


Raw-конвертация. Adobe Camera 
Raw

 Что такое raw-файл
Raw-файл — файл содержащий «сырые» данные снятые 

непосредственно с матрицы камеры
Raw-формат — это собирательное название для различных 

форматов, поскольку каждый производитель камер 
делает его по своей, закрытой от остальных, 
спецификации.  С этим связано различие цветов при 
проявке одного и того же файла различными 
конвертерами.  Поскольку ячейка матрицы воспринимает 
только информацию о суммарной засветке, сама 
матрица фотоаппарата выдает черно-белую картинку  
Чтобы заставить фотоаппарат воспринимать цвет, 
ячейки матрицы накрывают красными, зелеными и 
синими светофильтрами.  Чаще всего используется 
схема расположения светофильтров, предложенная 
Брассом Байером и получившая название «матрица 
Байера»





Восстановление недостающей поканальной 
информации называется демозаикой или 
дебайерезацией и происходит за счет 
интерполяции по соседним ячейкам. Основное 
преимущество raw-файлов состоит в том, что в них 
содержится большое количество избыточной (с 
точки зрения текущих параметров конвертации) 
информации, которую можно задействовать, 
меняя настройки при конвертации

Из-за линейности (примерной) сенсора в raw-файле 
содержится большое количество избыточной 
(дополнительной) информации в светах.  Raw-файл 
можно сравнить с отэкспонированной, но еще не 
проявлений пленкой, содержащей латентное 
(скрытое) изображение

Raw-конвертация в современном процессе обработки 
занимает то же самое место, что проявка пленки в 
аналоговой фотографии

В связи с улучшением математических алгоритмов 
конвертация старых файлов новыми 
конвертерами может дать существенно лучший 
результат

Дополнительные материалы
Антон Мартынов. «Зачем снимать в 
RAW?»
Для самостоятельного изучения
Михаил Афанасенков. «Разумно о фото»



Adobe Camera Raw (ACR)



Основные элементы интерфейса 
ACR

• Adobe Camera Raw (ACR) имеет свой собственный интерфейс и открывается в отдельном окне
• Чтобы развернуть окно на весь экран воспользуйтесь кнопкой, расположенной над правым верхним 

углом изображения
• Слева вверху находятся инструменты ручной доработки изображения, использование которых в ACR 

не очень оправдано, поскольку эти операции будет удобнее сделать после конвертации
• Основные шоткаты навигации в изображении соответствуют таковым в Photoshop
• В общих настройках модуля ACR нужно запретить работу с JPG и TIFF и проверить, что настройки 

конвертации будут сохраняться в xmp-файл
• Внизу под изображением в строчку перечислены основные предустановки параметров растрового 

изображения, к которому будет происходить конвертация
• Для изменения этих параметров нужно кликнуть по данной строке и в появившимся окне ввести 

необходимые параметры
• Справа гистограмма, поле с информацией о кадре, а ниже в столбик собраны регуляторы настройки 

параметров конвертации и постобработки
• В закладке Basic (Основные) содержатся все регуляторы, отвечающие за конвертацию изображения
• В закладке Tone Curve (Тоновая кривая) находятся две тоновые кривые: Parametric Параметрическая) и 

Point (Точечная)
• Форма параметрической кривой меняется за счет положения четырех движков: Highlights (Света), Lights 

(Светлые тона), Darks (Темные тона) и Shadows (Тени)
• Форма точечной кривой меняется как и в Photoshop за счет установки и сдвига точек на кривой
• Кривые работают одновременно и могут использоваться как два последующих корректирующих слоя
• Допускают поканальную коррекцию, но поскольку применяются к внутреннему представлению 

изображения, работа с ними не очень удобна



• Закладка Detail (Детализация) отвечает за повышение резкости и подавление шумов
• Повышение резкости соответствует первому этапу по Фрейзеру: повышение резкости по источнику изображения с целью 

компенсировать падение резкости возникающее в процессе оцифровки
• В цифровой фотографии основное падение резкости происходит из-за антиалайзинг фильтра и операции демозаики
• В современных конвертерах первичное повышение резкости происходит даже при нулевых пользовательских настройках
• Подавление шума актуально при больших значениях ISO
• При цифровой съемке хроматический шум требует более сильного подавления, поскольку смотрится очень неестественно.
• Подавление шумов специализированными программами (Neat Image, Noise Ninja) производится более аккуратно, чем стандартными 

средствами ACR 
• Через закладку HSL Adjustment (Настройка HSL) можно выборочно менять параметры отдельных цветов
• Закладка Split Toning (Разбиение тонов) организует раздельное тонирование светов и теней. На этапе первичной обработки 

изображения данная операций выглядит не очень уместной
• В закладке Lens Correction (Коррекция дистрофии) работа инструментов аналогично одноименному фильтру в Photoshop
• В данной закладке имеет смысл активировать ключ Remove Chromatic Aberration (Удалить хроматическую аберрацию), а все 

исправления геометрии оставить на долю Photoshop
• Закладка Effects (Эффекты) Позволяет добавить в изображение эффекты зерна и виньетирования. Целесообразность применения 

еще более сомнителна, чем применение раздельного тонирования
• В закладке Calibration (Калибровка) настройка Process (Версия) определяет алгоритм по которому происходит конвертация, для 

получения наиболее качественного результата лучше выбирать самый свежий алгоритм конвертации.
• Остальные настройки предназначены для ручной настройки цветопередачи за счет изменения характеристик светофильтров
• На сегодняшний день, с точки зрения точной цветопередачи, ручные настройки потеряли свою актуальность и используются в 

основном для обработки изображений нестандартным образом
• В закладке Presets (Наборы) сохраняются наборы настроек, которые можно быстро присвоить любому другому изображению. 

Сохраненные пресеты можно применять напрямую через Adobe Bridge не открывая ACR.
• В закладке Snapshots (Снимки экрана) можно сохранить варианты проявки данного изображения
• При нажатию на кнопку Open Image (Открыть изображение) происходит конвертация и изображение открывается в Photoshop
• При нажатию на кнопку Cansel (Отмена) конвертация отменяется, параметры не запоминаются
• При нажатию на кнопку Done (Готово) конвертация не происходит и изображение в Photoshop не открываются, но запоминаются 

введенные параметры проявки

Дополнительные материалы
Евгений Карташов. «Горячие клавиши Adobe Camera Raw»
Андрей Антонов. «О цифровом шуме и его устранении с помощью 
Neat Image»
Анатолий Скоблов «Где прячется кнопка "шедевр" или много цвета 
из ничего»



Проявка и настройка тональных 
характеристик

• В начале приводятся в порядок тональные (яркостные) характеристики изображения, а потом делается 
настройка цвета

• Перед тем, как настраивать проявку, нужно включить отображение отсечки в светах (красные пятна) и 
тенях (синие пятна)

• Включается / выключается отображение отсечки с помощью двух кнопок, расположенные в верхних 
углах гистограммы

• Регулятор Whites (Белое) сдвигает правый край гистограммы равномерно растягивая (сжимая) ее во 
всем диапазоне

• Сдвигая этот регулятор вправо, натягиваем правый край гистограммы на край тонового диапазона, до 
появления не слишком сильной, но заметной отсечки в светах

• Регулятор Highlights (Света) — тонмэпер, позволяющий выборочно затемнять / осветлять светлые 
участки изображения

• Сдвигая его влево, производим выборочное затемнение светлых областей для лучшего отображения 
имеющихся в них деталей

• Регулятор Blacks (Затемнение) сдвигает левый край гистограммы равномерно растягивая (сжимая) ее 
во всем диапазоне

• Сдвигая этот регулятор влево, натягиваем левый край гистограммы на край тонового диапазона, до 
появления не слишком сильной, но заметной отсечки в тенях

• Регулятор Shadows (Тени) — тонмэпер, позволяющий выборочно затемнять / осветлять темные участки 
изображения

• Сдвигая его вправо, производим выборочное осветление темных областей для лучшего отображения 
имеющихся в них деталей

• Регулятор Exposure (Экспонир) производит общую экспокоррекция изображения
• С его помощью подстраиваем экспозицию изображения после установки белой и черной точек, а если 

это необходимо, помогаем в работе одному из тонмэперов



Проявка и настройка тональных 
характеристик

• По окончании работы регуляторы Whites (Белое) и Blacks (Затемнение) оттягиваются над до 
исчезновения отсечки

• Для сравнения внешнего вида картинки до и после коррекции используются 4 кнопки в левом 
нижнем углу окна с изображением

• Регулятор Contrast (Контрастность) — повышение контраста в средних тонах аналогичное 
применению S-образной кривой

• Обычно в конвертере не используется, поскольку работа с контрастом в Photoshope более удобная и 
гибкая

• Результат проявки зависит только от финальных значений всех настроек, но не от порядка сдвига 
регуляторов

• Чаще всего настройку начинают с того параметра, который сильнее всего улучшит изображение
• При конвертации под последующую обработку в фотошопе мы должны получить изображение, 

допускающее эту обработку в достаточно широких пределах. Прежде всего оно должно позволять 
эффективно повышать контраст сюжетно-значимых объектов

• Это возможно только если картинка имеет «пластичные», не зажатые света и тени, допускающие 
затемнение и осветление (соответственно) без потери деталей

• Таким образом на выходе из конвертера мы должны получить не очень выразительное (с 
невысоким контрастом, сероватое, немного блеклое) изображение, содержащее максимум 
информации и допускающее последующую обработку.  При работе с пленкой подобный принцип 
формулировался как: «снимаем мягко, печатаем жестко». При съемке «мягкий», низкоконтрастный 
негатив позволял запечатлеть детали с очень большим перепадом яркости. При последующей 
печати на «жесткой», высококонтрастной фотобумаге мы выбираем, какие именно детали должны 
быть переданы на оттиске

• Применительно к конвертации этот принцип можно сформулировать так: «проявляем мягко, 
готовим к печати жестко»

• При конвертации сохраняем максимум деталей и делаем пластичное изображение, допускающее 
повышение контраста. При подготовке к печати в фотошопе «жестко» повышаем контраст, 
ориентируясь на самые важные для нас объекты

• Регулятор Clarity (Четкость) — усиление / ослабление средних пространственных частот 
изображения. Позволяет усиливать / ослаблять локальные объемы

• Регулятор Dehaze (Удалить дымку) — удаляет эффект контровой засветки, возникающий из-за 
расеяния света на рассеянных в воздухе частицах

• Регулятор Vibrance (Красочность) — повышение цветовой насыщенности с приоритетным 
воздействием на более нейтральные участки

• Регулятор Saturation (Насыщенность) — повышение цветовой насыщенности с приоритетным 
воздействием на более насыщенные участки



Особенности работы 
тонмэперов

• Если с помощью регулятора Shadows (Тени) не удается вытащить детали из теней, ему можно помочь с 
помощью положительной экспокоррекции регулятором Exposure (Экспонир)

• Если с помощью регулятора Highlights (Света) не удается в достаточной мере проявить детали в светах, 
ему можно помочь с помощью отрицательной экспокоррекции регулятором Exposure (Экспонир)

• При работе с пейзажем регулятор Highlights (Света) можно сдвигать даже в крайнее левое положение, вот с 
регулятором Shadows (Тени) нужно быть осторожнее, потому что именно высветление темного сильно 
уменьшает тональную перспективу

• В любом случае, результат всех коррекций оценивается визуально по окончании коррекции
• Темный тонмэпер Shadows (Тени) как правило очень хорошо вытягивает темные объекты в кадрах, снятых 

с сильным костровым светом
• Вытягивание деталей из теней, вне зависимости от того, каким инструментом оно делается, приводит к 

усилению шумов
• Экспокоррекцию в пределах одного стопа можно делать спокойно, в пределах двух стопов с 

осторожностью, в пределах трех стопов скрепя сердце
• При работе с портретом с регулятором Highlights (Света) надо быть крайне осторожно, поскольку он 

неестественно затемняет кожу
• Темный тонмэпер Shadows (Тени), примененный в разумных пределах, работает с портретами хорошо



Установка баланса белого
• С помощью установок White Balance (Баланс белого) производится 

компенсация цветности источника света, которым была освещена сцена
• Temperature (Температура) — приносит в изображение синий или желтый 

оттенок. Фактически, изменяет соотношение экспокоррекции красного и 
зеленого каналов с одной стороны и синего канала с другой

• Tint (Оттенок) — приносит в изображение зеленый или пурпурный оттенок. 
Фактически, изменяет соотношение экспокоррекции зеленого канала с одной 
стороны и красного и синего каналов с другой

• Установки баланса белого в большей степени действуют на области близкие к 
нейтральным, поскольку именно в них дополнительные оттенки проявляются 
сильнее всего

• Для быстрой установки баланса белого можно взять инструмент White Balance 
Tool (Баланс белого) и кликнуть по участку, который в жизни был серым

• Помните, что на цвет объектов влияют рефлексы и условия освещения
• При настройке цветового баланса «на глаз» можно временно выкрутить на 

максимум регуляторы Contrast (Контрастность), Vibrance (Красочность) и 
Saturation (Насыщенность). Таким образом все, даже незначительные, оттенки 
будут настолько усилены, что различать их станет гораздо легче

• После установки формально «правильного» баланса белого, его можно 
поправить просто по своему вкусу

• Если в кадре присутствует человек, после установки баланса белого «по 
серому», с большой вероятностью кожа будет казаться слишком красной

• Если картинка рассчитана под обтравку (человек будет вырезаться), или в 
кадре нет явных серых объектов, добавить темный оттенок можно слегка 
сдвинув баланс белого в желтую сторону

• Если сдвиг баланса белого дает неудовлетворительный результат, нужно 
править кожу выборочно, через настройки закладки HSL Adjustment (Настройки 
HSL)



HSL Adjustment

• В закладке HSL Adjustments (Настройки HSL) можно 
изменять оттенок, насыщенность и яркость для 8 
диапазонов цветов

• В разделе Hue (Цветовой тон) можно произвести тонкую 
настройку оттенка, например, сдвинув оранжевые цвета в 
желтую сторону

• В случае, если цвет кожи оказался слишком насыщенным, 
можно уменьшить значение в разделе Saturation 
(Насыщенность) для оранжевых оттенков

• В разделе Luminance (Светимость) регулировки лучше не 
трогать, поскольку высветление или затемнение 
отдельных оттенков дает крайне неприятный результат

• Настройки оттенка и насыщенности для различных цветов 
производят после настроек баланса белого

• Чтобы активнее менять цвет у слабо насыщенных 
объектов, можно предварительно сбить баланс белого. 
Это приведет к более выраженному оттенку и регуляторы 
Hue (Цветовой тон) и Saturation (Насыщенность) будут 
лучше захватывать их

• Оттенок остальных цветов можно поправить регуляторами 
Hue (Цветовой тон) в различных диапазонах

• Для более точного определения цветового диапазона в 
котором лежит нужный нам цвет можно использовать 
инструмент Targeted Adjustment Tool (Инструмент целевой 
корректировки)



Изменение размера и 
кадрирование изображения

• Для самостоятельного изучения
• Liveclasses. Adobe Photoshop: работа с геометрией 

изображения

Полутоновое растровое изображение
Полутоновое растровое изображение — массив 
квадратных элементов (пикселей)
Пиксель — минимальный «кирпичик» из которого состоит 
изображение
Каждый пиксель может быть окрашен в единственный 
цвет
По-умолчанию пиксель является квадратным, поменять 
его пропорции можно с помощью команды View > Pixel 
Aspect Ratio (Просмотр > Попиксельная пропорция), а 
включить отображение этих пропорций командой View > 
Pixel Aspect Ratio Correction (Просмотр > Коррекция 
пропорций)
Чтобы отключить отображение пиксельной сетки нужно 
деактивировать команду View > Show > Pixel Grid (Просмотр 
> Показать > Пиксельная сетка)
Размер оцифрованного изображения всегда измеряется 
только в пикселях, сам по себе пиксель размеров не 
имеет
Поскольку экран состоит из отдельных ячеек, вывод 
картинки на него происходит попиксельно: одна ячейка 
экрана окрашивается в цвет одного пикселя. То есть, при 
выводе картинки на экран важен только ее размер в 
пикселях



Размер изображения и 
отпечатка

• Размер оттиска или экрана измеряется в сантиметрах (дюймах)
• Разрешение изображения— коэффициент, показывающий сколько пикселей 

уложится в один сантиметр (дюйм) его отпечатка
• По традиции разрешение измеряется в количестве пикселей на 1 дюйм — ppi (pixels 

per inch)
• Размер изображения (пиксели) = Разрешение (пиксели на дюйм) х Размер оттиска 

(дюймы)
• Чем выше разрешение, тем больше пикселей умещается в одном дюйме, тем меньше 

размер пикселя
• При маленьком разрешении пиксель оказывается настолько велик, что мы начинаем 

различать отдельные пиксели
• Для полиграфии и фотопечати необходимо разрешение не ниже 300 ppi, эта величина 

вычисляется исходя из угловой разрешающей способности человеческого глаза
• Если при заданном размере печати разрешение изображение получилось меньше 

300 ppi, но больше 200 ppi, его можно искусственно увеличить до 300 ppi
• Более сильное искусственное увеличение изображения нежелательно, поскольку 

результат получается мыльным



Разрешение мониторов и 
принтеров

• «Разрешением» монитора обычно ошибочно называют количество ячеек по ширине и 
высоте экрана. Реальное разрешение монитора — это количество таких элементов на 
один сантиметр (дюйм) физического размера экрана

• При размещении в Интернете (выводе на экран) разрешение изображения, которое мы 
задаем в Photoshop, не играет роли, поскольку все размеры изображений измеряются в 
пикселях

• У большинства современных мониторов разрешение экрана 100-110 dpi, экраны Retina 
имеют разрешение 220 dpi, экраны современных смартфонов могут иметь разрешение 
до 500 dpi

• Разрешение принтера показывает с какой плотностью он может наносить на бумагу 
капли краски

• Для современных стройных принтеров типичным разрешением является 1440-2880 dpi
• Разрешение 72 ppi стало известным потому, что именно такое разрешение имел экран 

монитора, которым больше 25 лет назад комплектовались компьютеры Apple. На сегодня 
никакого смысла это число не имеет

• Разрешение 96 ppi появилось в Windows 95 для обозначения более современных 
мониторов

Для самостоятельного изучения:
Антон Мартынов. «Какое надо ставить 
разрешение у фотографии?»
Игорь Бондарь «Разрешение»



Изменение размера картинки. 
Команда Image Size

• Повернуть или отзеркалить изображение можно командами из меню Image > Image Rotation 
(Изображение > Вращение изображения)

• Команда Image > Image Size (Изображение > Размер изображения) позволяет изменять размер 
изображения и оттиска Вызывается комбинацией клавиш «Cmd+Opt+I» (на PC «Ctrl+Alt+I»)

• При снятом ключе Resample (Ресамплинг) размер изображения в пикселях сохраняется, а 
размер оттиска в сантиметрах и разрешение меняются обратно пропорционально друг другу

• В таком режиме команда превращается в очень удобный калькулятор, вычисляющий 
разрешение по заданному размеру оттиска, или размер отпечатка по заданному разрешению

• При установленном ключе Resample (Ресамплинг) может меняться любой из трех параметров, 
прямо пропорционально ему меняется один из двух оставшихся: при изменении размера 
изображения меняется размер оттиска (разрешение сохраняется); при изменении размера 
оттиска меняется размер изображения (разрешение сохраняется); при изменении разрешения 
меняется размер изображения (размер оттиска сохраняется)

• В выпадающем списке рядом с ключом Resample (Ресамплинг) выбирается алгоритм 
интерполяции по которому будут вычисляться цвета новых пикселей при изменении размера 
изображения

• Наилучшим является Bicubic (smooth gradients) (Бикубическая (плавные градиенты))

• Аналогичный алгоритм нужно выбрать в настройках Photoshop CC > Preferences > General 
(Photoshop CC > Настройки > Основные)

• При установленном ключе Constrain Proportions сохраняются пропорции изображения
• Кнопка с пиктограммой цепочки, расположенная слева от полей размера, позволяет 

автоматически сохранять пропорции при изменении размеров
• В правом верхнем углу под кнопкой с шестеренкой скрывается настройка Scale Styles 

(Масштабировать стили). Убедитесь, что она активна
• Чтобы подготовить изоборажение к выводу на экран вызываем команду Image > Image Size 

(Изображение > Размер изображения), проверяем, что ключ Resample (Ресамплинг) активен, 
выбираем в качестве единиц измерения пиксели и вводим нужный размер

• Чтобы подготовить изоборажение к печати действуем в два шага. Вызываем команду Image > 
Image Size (Изображение > Размер изображения), снимаем ключ Resample (Ресамплинг) и 
вводим размер отпечатка. Убеждаемся, что родное разрешение картинки не меньше 200 ppi, 
после чего ставим ключ Resample (Ресамплинг) и вводим разрешение 300 ppi



Изменение размера холста. 
Команда Canvas Size

• Команда Image > Canvas Size (Изображение > 
Размер холста) позволяет изменять 
размер холста, добавляя пустое поле или 
отрезая часть изображения

• Вызывается комбинацией клавиш 
«Cmd+Opt+C» (на PC «Ctrl+Alt+C»)

• В открывшемся окне вводятся новые 
значения ширины и высоты

• Если новый размер холста больше 
старого, к изображению будет добавляться 
новая область. Если новый размер холста 
меньше старого, часть изображения будет 
отрезана

• В поле Anchor (Расположение) указывается 
положение точки, которая не будет 
меняться, относительно этой точки будут 
происходить все изменения

• При включенном ключе Relative 
(Относительная) введенные значения 
задают не финальный размер, а 
изменение размера

• В списке Canvas extension color (Цвет 
расширения холста) задается цвет, 
которым будет закрашена дополнительная 
область холста на слое Background (Фон)

• На обычных слоях новая область будет 
прозрачной



Ручное кадрирование

• Свободное кадрирование производят инструментом Crop Tool (Инструмент Рамка)
• Быстро переключиться на этот инструмент можно нажав на клавишу «C»
• Перед тем, как начать работать с этим инструментом, желательно переключится в полноэкранный режим
• Передвигая боковые и угловые маркеры появившейся рамки мы задаем границы подрезки
• Повернуть картинку можно поставив курсор рядом с маркером за пределами области подрезки
• При установленном ключе Delete Cropped Pixels (Удалять отсеченные пиксели) изображение за пределами 

холста удаляется, если деактивировать этот ключ, изображение за холстом отрезано не будет и при 
повторном кадрирования его можно будет использовать

• Для быстрого выравнивания линии горизонта в палитре Options (Параметры) нажимаем на кнопку 
Straighten (Выпрямить) и указываем линию горизонта

• Настройка отображения вспомогательной разметки производится через кнопку с пиктограммой сетки, 
расположенную справа от кнопки Straighten (Выпрямить)

• В первом выпадающем меню палитры Options (Парметры) можно задать пропорции финального 
изображения

• Если нужной пропорции в списке не оказалось, можно вручную ввести соотношения вертикального и 
горизонтального размера в расположенные рядом со списком поля

• Возврат к свободному кадрирования осуществляется нажарим на кнопку Clear (Очистить)
• Если активировать ключ Content-Aware (С учетом содержимого), Photoshop будет автоматически создавать 

заплатку для тех участков, где рамка кадрирования выступает за границы исходного изображения
• Пункт Size & Resolution в первом выпадающем меню палитры Options (Парметры) позволяет задать размер 

и разрешение, к которым картинка будет приведена сразу после кадрирования



Исправление искажений оптики. Инструменты Lens 
Correction и Adaptive Wide Angel

• Фильтр Lens Correction (Коррекция дисторсии) исправляет геометрические искажения 
оптики

• Если фильтр сумел получить информацию о камере и объективе, на которые был снят 
кадр, он сможет автоматически исправить ряд искажений

• Из автоматических коррекций имеет смысл исправлять только дисторсию, активировав 
ключ Geometric Distortion (Геометрическое искажение)

• Если автоматическое удаление не сработало, дисорсию правят вручную в закладке 
Custom (Заказная)

• Наиболее ценным из ручных настроек является исправление трапециевидных 
искажений: Transform > Vertical Perspective (Перспектива > По вертикали)

• При исправлении вертикальной перспективы не надо приводить все вертикали к строго 
вертикальному состоянию. Иначе будет ощущение, что вверху кадр расходится

• Ручной регулятор поворота работает слишком резко, поэтому угол поворота приходится 
задавать в цифровом поле

• Для исправления сверхширокоугольной оптики используется фильтр Adaptive Wide Angle 
(Адаптивный широкий угол)

• После того, как мы указываем линию, которая должна была быть прямой, но из-за 
искажений оптики получилась выгнутой, фильтр деформирует картинку так, чтобы эта 
линия выпрямилась

• При использовании этого фильтра не нужно увлекаться: если задать слишком много 
прямых линий, картинка будет деформироваться слишком сильно


